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This module focuses on the various NetWorker resource types and their functions. The 
several NetWorker administrative interfaces are also introduced. 
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This lesson covers an introduction to NetWorker resources and the Resource Administration 
Platform (RAP) protocol.  
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Resources are used to configure a NetWorker environment. These resources are managed as 
configurable objects by the NetWorker administrator. Resource types include clients, devices, 
tape libraries, backup policies, backup start times, and numerous other configurable 
components of the backup environment. Anything configurable to NetWorker is configured as a 
resource. 

A resource is defined by its attributes and the values of those attributes. For example, in the 
slide above, the client resource for bongo has a Save set attribute configured such that the 
/oracle directory is backed up, and a Group attribute of Default, which causes bongo to be 
backed up at 3:33 am.  There can be multiple configurations for each resource type.  

Nearly all of the resources are stored on the NetWorker server and managed by the nsrd 
daemon.  

A few resources are managed on the NetWorker client. 
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NetWorker uses the Resource Database to store the resources for a NetWorker data zone. 

Resource database information is distributed using the Resource Administration Platform (RAP) 
protocol. The information in the resource database is managed via NetWorker administrative 
interfaces. The resource database exists on the NetWorker server. There is one file per 
configured resource and each file is stored in any of ten subdirectories (00-09) under 
/nsr/res/nsrdb. The master NetWorker server daemon, nsrd, handles all queries and update 
requests to the database. 

A small amount of resource information exists on NetWorker clients in the /nsr/res/nsrladb 
directory. 

Important: Resource files are text files and are to be modified only using NetWorker’s GUI and 
command-line interfaces.  DO NOT EDIT THEM! 

Note: Other files and directories may exist in /nsr/res.  These are discussed as necessary later in 
the course. 
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NetWorker uses many resource types to define its configuration, with each resource type 
serving a specific purpose and representing a configuration point for the product. The slide lists 
some of the many resource types managed by the NetWorker server with a brief description of 
the function of each one. These resource types are discussed within this course.  

Each NetWorker resource type has a manual page (man page) named nsr_resourcetype(5). For 
example, the man page nsr_client(5) describes the attributes of a client resource and the 
function of each attribute. Resources are also documented in the EMC NetWorker 
Administration Guide. 

Example  - View the man page for the device resource. 

     # man nsr_device              

Resource types contained in the nsrladb directory on NetWorker clients are documented in the 
man page for the utility that uses the resource. 

Note:  On NetWorker hosts running Microsoft Windows, the manual pages are available in the  
EMC NetWorker Command Reference Guide. 
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This lesson covered an introduction to NetWorker resources and the Resource 
Administration Platform (RAP) protocol.  
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This lesson introduces the three NetWorker administrative interfaces: 

• NetWorker Management Console 

• Nsradmin 

• nsrwatch 
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The NetWorker Management Console provides a global view of all NetWorker servers in your 
environment. In addition to the Console, two other administrative interfaces may be available 
depending on whether you are on a UNIX or Windows host. 

nsradmin is a command-line utility used to view, create, delete, and modify resources.  When 
run on a UNIX host, it can be run in full-screen mode using a curses-based interface.  The curses 
API is not available in Microsoft Windows. 

nsrwatch is a monitoring tool used to view current device operations, active sessions, 
messages concerning recent activity, and any “pending” messages such as an unfulfilled volume 
mount request.  nsrwatch is curses-based and can be run only on UNIX hosts. 
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In addition to providing centralized event and library management and reporting capabilities, 
the NetWorker Management Console GUI provides access to each managed NetWorker server 
in an environment for NetWorker administration functions including configuring clients, devices 
and other resources, and scheduling, running, and monitoring backups.   Additionally, any Data 
Domain or Avamar servers integrated into the NetWorker environment can be monitored by the 
NMC. 
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The first time NetWorker Management Console is launched, a License Agreement window is 
displayed. You must accept the agreement before using NetWorker Management Console.  

When first launching Console, the Console Configuration Wizard begins and the Welcome to 
the Console Configuration Wizard window is displayed. The wizard will walk you through some 
initial configuration settings. 

The first configuration task is to set the password for the Console server default administrator 
user. 

Note:   All of the settings in the wizard can also be configured by using the Console menu 
options. These options are discussed in more detail in the course in the module,  Administering 
the NetWorker Management Console Server. 
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Next, specify the NetWorker server that contains the audit log configuration in the Set Audit 
Log Server Name window. 

In the Set Database Backup Server window, specify the NetWorker server and client that will be 
used to backup the NetWorker Management Console server database. Note that the default 
option is to automatically create a client resource on the specified NetWorker server to backup 
the Console database.  

In the Add NetWorker Servers window, define the NetWorker server(s) that the Console server 
will manage. The features selected by default in the wizard allow the Console server to collect 
data from the NetWorker servers pertaining to NetWorker events and to gather other data used 
to generate reports. This information is gathered by default, but may be ignored by de-selecting 
either or both items. 
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The NetWorker Management Console consists of two main windows: the Console window and 
the Administration window.  

The main NetWorker Console window consists of a menu bar and task bar with three large 
buttons labeled Enterprise, Reports and Setup. Clicking one of these buttons invokes a window 
for performing the tasks specific to that function. These tasks are discussed in more detail in the 
module, Administering the NetWorker Server.  

Note: The Enterprise window is initially displayed when Console is first opened. For subsequent 
startups of Console, the window that was last active during the previous session is displayed. 
The Getting Started window is automatically displayed when Console opens. It is essentially the 
online help system with a number of links to common tasks performed when initially 
configuring a NetWorker data zone. To keep this window from opening each time Console is 
started, uncheck the box at the bottom of the window. 
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To display a list of NetWorker servers managed by the Console server, click Enterprise in the 
task bar. In the left pane, a hierarchical list of managed NetWorker servers is displayed.  

Clicking a server in the list causes its managed application to be displayed in the right pane.  
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Double-clicking the managed application, NetWorker, results in a connection being made to 
nsrd on the NetWorker server, requesting resource information which is displayed in the 
NetWorker Administration window that is opened. This window is referred to as the 
Administration window for the remainder of the course. 

The Console window remains open and available after it is used to start NetWorker. This allows 
you to perform multiple tasks simultaneously, such as running NetWorker Administration for 
several NetWorker servers. A separate NetWorker Administration window is opened for each 
NetWorker server. 

NetWorker servers are managed through the Administration window. Notice that the task bar 
of the Administration window is different than that of Console. Upon initial startup, the 
Monitoring task window is displayed. Upon successive startups, whichever window was active 
during the previous session displays. 
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The slide shows the contents of some of the menus available from the Monitoring window. 
These menus also exist in the Configuration, Devices, and Media windows and have many of 
the same selections. The menus not described above may vary, depending on the task bar 
selection, or may not exist at all in certain windows.  They are discussed as needed during the 
course. 

There are three selections in the View menu worth highlighting at this time: 

View Parallel – This selection allows you to view multiple windows simultaneously and is often 
used in conjunction with Window > Tile Vertically or Window >Tile Horizontally. 

Choose Table Columns – This selection opens a window from which you can select which 
columns in the current window to display or hide. 

Diagnostic Mode – When viewing resources, many attributes are hidden by default. To display 
all attributes when viewing a window, enable diagnostic mode.  
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From the NetWorker Administration Monitoring window the administrator can view the 
status of completed backups and those in progress, look at alerts and log messages (always 
visible by default), and manually start group backups. 

The Monitoring window has a docking panel which allows you to view several monitoring 
panes at once. Use the Groups panel to manually start group backups. The Sessions pane is 
used to view the sessions that are running on the Networker server. The Devices pane is used 
to monitor the status of all devices. 

Also, alerts and log messages are displayed in panels at the bottom of every window in 
NetWorker Administration. 
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The Configuration window is used to access most of the configurable NetWorker resources. 
Tasks that can be performed from this window include creating new resources, and modifying 
and deleting existing resources. By double-clicking the resource type (e.g. Clients) in the left 
pane, details about the individual resources created under that type are displayed in the right 
pane of the window. Double-click a row in the right pane to open the resource’s Properties 
window in which you can modify attribute values of the resource. You can also edit an attribute 
for multiple resources at the same time by selecting each resource and then placing the cursor 
in the column you want to change. 
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The Devices window is used to configure and manage libraries (i.e., jukeboxes, autochangers) 
and standalone backup devices.  Additionally both integrated Avamar deduplication nodes and 
Data Domain systems are displayed here.   
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The Media window is used to manage pools and to view information contained in the media 
database and client file indexes.   
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The Recovery window is used to configure, manage, and monitor scheduled and on demand 
recovery sessions.   
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This slide demonstrates how to view log messages and Alerts in the GUI. By using the up and 
down arrows we can maximize and minimize the windows to view the Log and Alert windows. 
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This slide demonstrates how to float windows in NetWorker Administration. As an example, 
with the float windows option, we can  maximize and minimize the windows to float the Log 
and Alert windows. 
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nsradmin is a command-line utility used to view, create, delete, and modify NetWorker 
resources. It can be run from any NetWorker host. To open a connection to a specific 
NetWorker server, run the command with the -s server option.  

After starting nsradmin, enter nsradmin-specific commands at the nsradmin> prompt. The 
format of a nsradmin command is: 

 cmd [argument [;argument]] 

where cmd is a name of a command and argument is specified in the form of an attribute 
list. An attribute is a name optionally followed by a colon, followed by one or more values 
separated by commas. One or more attributes are separated by semicolons. 

For example, in the screen shot on the right, the print type: NSR client command is used to 
display all the attributes of all client resources in the resource database. To limit the output 
to a single client, for example, leg-win1, the command is:  

 print type: NSR client; name: leg-win1 

nsradmin can also run in a non-interactive mode using a specified text file for the command 
list. 

See the nsradmin topic in the EMC NetWorker Command Reference Guide or the UNIX/Linux 
man pages for a list of nsradmin options, resources and commands. 
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On a UNIX NetWorker host, nsradmin can be run in full-screen (visual) mode which uses a 
curses(3) interface.   

You can run nsradmin in visual mode by using either of two methods. 

•   Use the –c option. 

# nsradmin -c 

•   Run nsradmin without the –c option and enter visual at the nsradmin> prompt. 

The tab key, as well as the arrow keys, can be used to move the cursor to the appropriate piece of 
information on the screen.  Menu items on the top line of the window can be selected either by 
moving the cursor to the item and hitting <ENTER/RETURN> or pressing the first character of the 
item.  Once positioned at the desired attribute, use the arrow keys to go left or right, and the 
<DEL> key to remove the character to the left of the cursor. 

For more information about nsradmin, see the EMC NetWorker Command Reference Guide or the 
UNIX/Linux man pages. 

Note: To use visual mode for a Windows NetWorker server, run nsradmin with the  
-s nwserver option on any UNIX NetWorker host. Replace nwserver with the name of the 
Windows NetWorker server. This requires giving special privileges, which will be discussed later, 
to the UNIX host. 

Module 3: NetWorker Resources and Administrative Interfaces 24 
https://t.me/learningnets

ankit
Highlight



   Copyright © 2013 EMC Corporation. All rights reserved. 

nsrwatch is a curses-based utility used to monitor NetWorker server status and activity. It can 
be run from any UNIX terminal window having full-screen functionality.  

Performing an interrupt (usually <CTRL>c) or pressing q quits the program. Pressing any other 
key updates the information displayed. 

See the EMC NetWorker Command Reference Guide or the UNIX man pages for more 
information about nsrwatch. 

Note:  To monitor a Windows NetWorker server, run nsrwatch with the -s nwserver 
option on any UNIX NetWorker host.  Replace nwserver with the name of the Windows 
NetWorker server.  
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This lesson covered an introduction to the three NetWorker administrative interfaces:  
NetWorker Management Console, nsradmin and nsrwatch.  
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In this lab, you will: 

• Launch Console and define a NetWorker server to manage. 
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This module covered the various NetWorker resource types and their functions. The several 
NetWorker administrative interfaces were also introduced. 

Module 3: NetWorker Resources and Administrative Interfaces 28 
https://t.me/learningnets


